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1. Introduction 
 
Congratulations on choosing the ClearReader+, an intuitive portable reading assistant 
developed by Optelec. 

The Optelec ClearReader+ combines ease of use with high quality multilingual speech output 
and fast text recognition. It can capture any printed material such as letters, newspapers, and 
books, and reads text aloud with a naturally sounding voice. The built-in speakers provide high-
quality stereo sound.  

If you have any questions or suggestions concerning the use of the Optelec ClearReader+, 
please contact your Optelec distributor using the contact information on the last page of this 
manual. Your feedback is greatly appreciated, and we hope you enjoy using your ClearReader+. 

1.1. About this manual 
At Optelec, we are constantly improving our products and their functionalities. Therefore, it is 
possible that this manual is not the latest version. Please download the most up-to-date manual 
on www.optelec.com at the Support section. 
 
This manual will familiarize you with the features and easy operation of the ClearReader+. 
Please read this manual carefully before using your Optelec ClearReader+. 
  

http://www.optelec.com/
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1.2. What’s in the box 
Refer to the lists below to see what should be in the packaging of the ClearReader+ you 
received. If any of these items are missing from your package, contact your Optelec distributor. 
 

The ClearReader+ packaging contains the following: 
• The Optelec ClearReader+ 
• A power supply 
• A power cord 
• ClearReader+ Setup and Use 
• ClearReader+ Safety and Care 

 

The ClearReader+ Basic packaging contains the following: 
• The Optelec ClearReader+ 
• A power supply 
• A power cord 
• ClearReader+ Basic Setup and Use 
• ClearReader+ Safety and Care 

 

The Magnification Feature Pack packaging contains the following: 
• The Magnification Feature Pack   
• An SD card 
• ClearReader+ Magnification Feature Pack Setup and Use 
• ClearReader+ Safety and Care 
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2. Getting to Know Your ClearReader+ 
This chapter will familiarize you with your Optelec ClearReader+. 
 
2.1. The ClearReader+ Family 
There are three members of the ClearReader+ Family: ClearReader+, ClearReader+ Basic and 
Magnification Feature Pack. This user manual will elaborate on the use of all ClearReader+ 
types. Please note that not all functionalities described in this manual apply to all ClearReader+ 
types. 

2.1.1. ClearReader+ 
The ClearReader+ features an integrated battery. Thanks to this, you can enjoy reading without 
the need to be in close proximity of a mains power outlet. 

2.1.2. ClearReader+ Basic 
The ClearReader+ Basic does not have an integrated battery, but is AC powered. To use the 
ClearReader+ Basic, please connect to a mains power outlet to power the ClearReader+ Basic. 

2.1.3. Magnification Feature Pack 
The Magnification Feature Pack will add magnification options, as well as advanced navigation, 
viewing and reading functionality to your ClearReader+. Use the ClearReader+ and the Feature 
Pack with a monitor to magnify text. The Magnification Feature Pack can be used with the 
ClearReader+ and ClearReader+ Basic. 
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2.2. The Optelec ClearReader+ and ClearReader+ Basic layout 
 

 

Swing-out camera arm 
 

Camera 
 

Object lighting 
 
 

Built-in speakers 
 

Document positioning 
indicators 

 
 

Capture area 
 

Foldable carrying 
handle 
 
Power indicator 
 
Power button 
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Swing-out camera arm Open the arm to capture a document. 
 
 

Camera To take a snapshot, position the document in front of the 
ClearReader+. Use the document positioning indicators on the bottom 
left and right of the ClearReader+ to position the document. The 
document area is approximately the width of the ClearReader+ and 
the length of a regular A4 or letter size page.  

 
 

Object lighting The ClearReader+ automatically provides sufficient lighting when 
taking a snapshot. 

 
 

Built-in stereo speaker Listen to your letters, newspaper or books. 
 
 

Foldable carrying handle Open the handle to lift and carry the ClearReader+ comfortably. 
 
 

Power indicator Light is on when the power is on, blinks in standby mode, and is off 
when the power is off. 

 
 

Power button Press the round button on the right-hand side to turn the 
ClearReader+ on or off. 
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2.3. Buttons 
 
 
      Play / Pause button  Speed dial  Volume dial 
 

 
 
  Back button  Forward button  Scan button 
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2.4. Connections 

 
 
 
Power connector Connect the power supply to your ClearReader+. 
 
 
Audio out Connect audio output device if needed. 

Power connector 

Audio out 

SD slot 

USB port 
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2.5. The Magnification Feature Pack buttons 
The following figure shows the Magnification Feature Pack buttons: 
 
 Left Mode Up Menu Right 
 

 
 
 Play / Pause Down 
              
Play / Pause button: Round button in the centre of the remote control to stop and restart 

reading. Press and hold down the button for 2 seconds to spell the 
current word. Pressing the Play / Pause button within the menu will 
activate the button, cycle through the available options, check or 
uncheck the selection or enter a submenu.  
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Left arrow key: Press to navigate to the previous word or to the previous menu item in 
the menu. During playback of the text, this button will decrease the 
reading speed.  

 
 

Right arrow key: Press to navigate to the next word or to the next menu item in the menu. 
During playback of the text, this button will increase the reading speed.  

 
 

Up arrow key: Press to navigate a line up in the text, or to move to the previous menu 
item in the menu.  

 
 

Down arrow key: Press to navigate a line down, or to move to the next menu item in the 
menu.  

 
 

Mode button: Square button on the left half of the remote control. Short press to 
switch between the viewing modes: Column, Line, Page high contrast, 
Page full color and Overview mode. Long press to hear the page 
orientation. 

 
 

Menu button: Square button marked with the character “M” on the right half of the 
 remote control. Press to enter and exit the menu. 
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3. Getting Started 
3.1. Using the ClearReader+ for the first time 
When you use the Optelec ClearReader+ for the first time, the battery needs to 
be charged. To charge the battery, connect the ClearReader+ to a mains 
power outlet using the ClearReader+ power supply. Charging takes 
approximately 3 hours.  

3.2. Opening the camera arm 
To open the camera, locate the “push” sign on the camera arm at the front 
of the ClearReader+ between the speakers. Gently push on the camera arm 
until you hear a click. The arm will eject and move towards you. Close the 
camera arm in the same way by pushing the end of the arm back to the 
closed position until you hear a click. 

3.3. Positioning a document 
The Optelec ClearReader+ camera can capture an area of an A4 or letter-
size page measured from the front side of the ClearReader+. To position the 
document, place it in front of the ClearReader+ between the two document 
positioning indicators with the top edge of the document aligned towards the 
front of the unit. The orientation of the document will not influence the 
recognition of the text. 
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3.4. Turning on the ClearReader+ 
To turn on the ClearReader+, press the round Power button on the right-hand 
side. The start-up process will take approximately 40 seconds. You will hear a 
series of beeps to indicate that the ClearReader+ is starting up followed by the 
start-up sound. Now the Power indicator is lit up and the ClearReader+ is ready 
to use.  

3.5. Standby mode 
The ClearReader+ will go into standby mode by pressing and holding down the Back button and 
Forward button for 2 seconds. The standby sound will be played, the Power indicator will start 
blinking and the ClearReader+ will go into standby mode. To wake up the ClearReader+ from 
standby, press the Power button. When the batteries are fully charged, the standby time of the 
ClearReader+ is approximately 40 hours. After 40 hours the ClearReader+ will power down. If 
switching-on the ClearReader+ from the standby mode, the start-up process will take 
approximately 5 seconds. 

3.6. Turning off the ClearReader+ 
Press the Power button to power down the ClearReader+ completely. The power down sound 
will be played and the Power indicator will turn off. 
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3.7. Reading text 
Press the Scan button to capture and start reading a document positioned beneath the camera. 
After pressing the Scan button, you will hear the snapshot sound and within a few seconds the 
ClearReader+ will begin reading to you.  
 
You can capture pages in manual mode or Automatic mode. The default is “Manual”, where you 
press the Scan button each time you capture a page. With Automatic mode, you do not need to 
press the Scan button. The light comes on, and the camera checks for movement. Once a page 
is placed beneath the camera and no motion is detected, the camera scans the page. After, you 
hear the snapshot sound, the text is processed and the page is read to you. The text is also 
displayed if you have an HDMI connection to a monitor. 
 
To use Automatic mode, you must change the capture mode in the Options submenu of the 
Settings menu. Once you leave the menus, you can start scanning by placing a page in the 
capture area. To temporarily stop Automatic mode, press the Scan button. To restart Automatic 
mode, press the Scan button again. To return to manual mode, you must return to the Options 
submenu. 
 
Note: You cannot read tables and spreadsheets in Automatic mode. You must set the capture 
mode to “Manual” in the Options submenu before capturing columnar or tabular pages.  
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In either mode, each new page will replace the current page unless you are saving a multipage 
document. 

3.8. Reading tables and spreadsheets 
To read tables, receipts, and bank statements, press and hold the Scan button for more than 2 
seconds until you hear a clicking sound. A long press of the Scan button will enable the Table 
Reading mode and will disable the automatic column recognition, making it possible to read 
across columns. Text will be read from left to right ignoring column borders. 
 
Note: The capture mode must be set to Manual in the Options submenu of the Settings menu 
before capturing columnar or tabular pages. 

3.9. Adjusting the volume 
Turn the Volume dial clockwise and release it to slightly increase the volume of 
the reading voice. Alternatively, turn the dial counterclockwise and release it to 
slightly decrease the volume. To rapidly adjust the volume, turn and hold the dial 
to the end position. When releasing the dial, it will always move back to its start 
position. 
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3.10. Adjusting the reading speed 
Turn the Speed dial clockwise and release it to slightly increase the reading 
speed. Alternatively, turn the dial counterclockwise and release it to slightly 
decrease the reading speed. To rapidly adjust the reading speed, turn and hold 
the dial at the end position. When releasing the dial, it will always move back to 
its start position. 

3.11. Play or pause reading 
The ClearReader+ will automatically start reading after pressing the Scan 
button. To pause reading, press the Play / Pause button. Press this button once again to 
continue reading.  

3.12. Spelling a word 
To spell a word, press and hold the Play / Pause button until you hear a click. Character by 
character, the word will be spelled out loud. 

3.13. Navigate back in the text 
Press the Back button to navigate to the previous word. Press and hold the Back button for 2 
seconds to navigate to the previous sentence.  
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3.14. Navigate forward in the text 
Press the Forward button to navigate to the next word. Press and hold the Forward button for 2 
seconds to navigate to the next sentence.  

3.15. Navigate to the beginning of the document 
To navigate to the beginning of the document, Press the Back button and Play / Pause button 
simultaneously. 

3.16. Selecting the reading voice or language 
To select your preferred reading voice or reading language, press and hold the Back button 
while turning the Speed dial at the same time. The ClearReader+ will switch to the next voice 
and announce the name of the newly selected voice and the language. For optimal 
performance, the reading language and language of the document need to match. If the 
language of the document does not match the selected reading language, the text recognition 
will be of a lower quality and the recognition will take longer. 
 
Note: In case automatic language detection is enabled, this button only changes between 
voices of the detected language. For instance, if the detected language is English this button will 
only change between the different English voices. With automatic language detection enabled, 
you will not be able to change the language of the menu. To change the menu language, either: 
1) disable automatic language detection, or 2) scan a document in your preferred menu 
language and change the voice once in the menu. 
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4. The Magnification Feature Pack 
4.1. Introduction 
The Magnification Feature Pack will add magnification options, as well as advanced navigation, 
viewing and reading functionality to your ClearReader+ or ClearReader+ Basic. Use the Feature 
Pack without the monitor to listen to the document captured on the screen, or with the monitor to 
magnify it.  

4.2. Connecting the Magnification Feature Pack to the Optelec ClearReader+ 
Connect the Magnification Feature Pack to the ClearReader+ and optionally, a monitor. Locate 
the HDMI connector at the bottom rear side of the ClearReader+. If the HDMI connector is not 
visible, you will need to remove the protection cover which will also reveal two USB connectors. 
Use a Philips screwdriver to remove the screw which closes the cover. This screw is located in 
the middle of the cover at the bottom side of the ClearReader+. Connect the monitor to the 
ClearReader+ by using a HDMI cable. Adjacent to the HDMI connector, there are two USB 
ports. Connect the USB cable of the ClearReader+ Magnification Feature Pack to one of the two 
USB ports on the rear side or to the USB port on the right side of the unit. 
 
When the Magnification Feature Pack is connected to the ClearReader+, switch on the 
ClearReader+ and take a snapshot of a document as described in this manual. 
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4.3. Magnification Modes 
With the Magnification Feature Pack, you can view captured documents in different viewing 
Modes: Column, Line, Page high contrast, Page full color and overview mode. To switch 
between the different Modes, press the Mode button on the Magnification Feature Pack. 

To set the default viewing mode and options adjust the appearance of the text such as size, 
color, word highlight, or font can be found within the ClearReader+ Menu.  

4.4. Page Mode 
The Page Mode shows a photograph of the document in its original layout, including the 
pictures. There are 2 Page modes, the high contrast Page mode and full color Page mode. In 
the high contrast Page mode, the text is displayed in the selected high contrast colors. 

4.5. Column mode 
In the Column mode the text is reformatted and displayed in a column to fit the width of the 
screen regardless of the text size. Pictures are not shown in this mode.  

4.6. Line mode 
In Line mode the text is reformatted and displayed in one continuous line, and the highlighted 
word is always displayed at the centre of the screen. Pictures are not shown in this mode. 
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4.7. Overview 
In the Full page overview, the full page is being shown with blue numbered bullets marking the 
detected text zones in the document. The navigation bullets can be used to quickly navigate 
through a text. Navigate between the bullets by pressing the Play / Pause button plus the Up 
arrow to go to the previous zone and the Down arrow to go to the next zone. The speech will 
start reading the selected text zone. The number of the navigation bullets represent the most 
likely order of the text. The speech reads the zone with navigation bullet number 1, followed by 
navigation bullet number 2, and so on.  

4.8. Reading and navigating with the Magnification Feature Pack 
You can navigate to the next or previous line of the text by pressing the Up or Down arrow keys. 
To move a screen up in a document, press the Play / Pause button together with the Up arrow 
key. To move to the next screen, press the Play / Pause button together with the Down arrow 
key. In page overview, pressing Play / Pause together with the up or down arrow will navigate to 
the previous or next bullet or text zone. To go to the start or end of the document, use the Left 
plus Up arrow keys or Right plus Down arrow keys respectively. If you are reading a book press 
the Play / Pause button in conjunction with the Right arrow key to go to the next page. To go to 
the previous page, press the Play / Pause button with the Left arrow key. 

By default, the ClearReader+ will recognize columns. If you wish to disable the column 
recognition to read tables, press and hold the Play / Pause button and press the View button. 
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To start or stop reading, press the Play / Pause button. While reading, the text will scroll 
automatically. To decrease the reading / scrolling speed, press the Left arrow key. Alternatively, 
press the Right arrow key to increase the reading / scrolling speed. 

A long press of the View button will announce the page orientation.  
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5. The ClearReader+ Menu 
This chapter will familiarize you with the ClearReader+ Menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change 
settings 

Change viewing 
mode 

Change 
voice 

Delete 
saved documents 

Open 
documents 

Save 
documents 
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5.1. Activating and closing the menu 
Without the Magnification Feature Pack, to activate the menu, press the Play / Pause button 
together with the Forward button on the ClearReader+. With the Magnification Feature Pack, 
press the square button on the Feature Pack marked with the character “M”.  
To close the menu, press the Play / Pause button together with the Forward button again, or 
use the Menu button on the feature pack.  
 
Action ClearReader+ Magnification Feature Pack 
Open Menu Play + Forward Menu 
Close Menu  Play + Forward Menu 

 

5.2. Using the menu 
The ClearReader+ menu contains two rows of three large buttons. To activate a button, navigate 
to the button using the Back button and Forward button on the ClearReader+. Press the Play / 
Pause button to activate the selected menu button. If you have a Magnification Feature Pack, 
use the Up, Down, Left and Right arrows to navigate through the menu. Press the Play / Pause 
button to select a menu item. Activating a menu button with the Play / Pause button will either 
change a setting or open a submenu or list. If a button is greyed out, the option is not available. 
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Action ClearReader+ Magnification Feature Pack 
Next Menu Item Forward Arrow Right / 

Arrow Down 
Previous Menu Item Back Arrow Left / 

Arrow UP 
Select / Activate Play Play 

 
The menu contains the following buttons: 

• Save 
• Voice 
• Open  
• View 
• Delete  
• Settings 

5.2.1. Save 
To be able to save documents, you will need to insert a SD card into the SD slot above the USB 
port on the right-hand side of the ClearReader+. Alternatively, you can use a USB memory stick 
to save documents. By default, a document will be saved on the SD card. If you wish to save 
your document on a USB drive, connect a USB drive to the ClearReader+. When a USB drive is 
connected, the document will always be saved on the USB drive. 



ClearReader+ Optelec 
 

28 English 

 
To save a document, open the menu and navigate to the blue Save button with the Back and 
Forward button on the ClearReader+ or the arrow keys on the Magnification Feature Pack. 
Activate the Save button with the Play / Pause button.  
 

      
 
First you will be asked in what format you would like to save the document: 

• Document: this is the standard ClearReader+ format 
• e-PUB: This is an e-reader or Daisy compatible format 
• DOCX: Use this document if you would like to edit the document on a PC with Microsoft 

Word 
• MP3: Selecting this format will save the document as an MP3 audio file.  
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When saving a document as an audio MP3 file, you will need to select the reading voice. The 
list of voices to choose from are the Nuance voices of the selected language, or the voices of 
the languages detected if automatic language detection is enabled.  
Not all voices can be used to save as an MP3 audio file. The available voices are limited to only 
the Nuance voices. In case no Nuance voice is installed, the MP3 button will be greyed out and 
this option is not available for the selected language.  
 
Only one voice will be used for the entire MP3 file. Automatically switching between languages 
within an MP3 audio file is not supported.  
 
Saving a document in MP3, DOCX or e-PUB takes longer than the standard format. Especially 
saving a multipage document in MP3 format could take several minutes.  
 
After you selected the format to save the document in, you will be asked if you would like to 
save your document with a voice label. 
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If you wish to save a document without a voice label, select “No”. The document will be saved 
using the first line of the document as the name of the document. If you would like to add a 
voice label, select “Yes”. You will hear a beep after which you have 5 seconds to record a voice 
label. At the end of the recording, you will hear another beep. The document will be saved with 
the recorded voice label. 
 
When the document is saved, the ClearReader+ will ask if you would like to append more pages 
to the document. 
 
If you select “No”, the menu will be closed, showing the document again. If you select “Yes”, you 
can start appending more pages to the document by pressing the Scan button. To stop 
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appending pages to the document, press the Menu button marked with the “M” or the Play / 
Pause key on the ClearReader+. 
 
The ClearReader+ will prompt you with the question if the captured pages should be processed. 
If “No” is selected, the conversion to text will be done while reading the document. If “Yes” is 
selected, all pages will be processed before returning to the document reading mode. This 
process may take several minutes, depending on the number of pages of the document. 
 
Appending pages and saving a document works the same in Automatic mode and Manual 
mode. However, Automatic mode is helpful when you want to save a multipage document. The 
process moves more quickly since you do not have to press the Scan button each time you put 
down a new page. To stop motion detection, press the Scan button; press the Scan button 
again to restart automatic scanning.  

5.2.2. Open 
To open a document, open the menu and navigate to the green Open button with the Back and 
Forward button on the ClearReader+ or the arrow keys on the feature pack. Activate the Open 
button with the Play / Pause button. Select the “Document” button to see the list of saved 
documents, showing the most recently saved document first. To open and view pictures, select 
the “Pictures” button. 
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Scroll through the list of documents or pictures using the Back button or Forward button on the 
ClearReader+, or the arrow keys on the Magnification Feature Pack. Open a document by 
pressing the Play / Pause button.  
 
In the list with documents or pictures, use the Play / Pause button to open the document or picture 
you wish to read or view. The menu will be closed, and the document or picture will be opened. It 
is also possible to open text documents in “txt” format or photos from a USB stick. To open 
documents in “txt” format, the document should be located in the root of the USB stick or SD card.  
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5.2.3. Delete 
To delete a document, open the menu and navigate to the Delete button with the Back and 
Forward button on the ClearReader+ or the arrow keys on the Magnification Feature Pack. 
Activate the Delete button with the Play / Pause button. Select the document you wish to delete. 

          

 
You will be prompted to confirm to delete the document. To delete the document, select “Yes”. 
To cancel deleting the document, select “No”. Both choices will return you to the list of 
documents. 



ClearReader+ Optelec 
 

34 English 

5.2.4. Voice 
This menu item lets you select your reading voice and language. To select another reading 
voice, open the menu and navigate to the Voice button with the Back and Forward button on the 
ClearReader+ or the arrow keys on the Magnification Feature Pack. To change the voice or 
language, press the Play / Pause button.  
 

 
 
The ClearReader+ will switch to the next configured voice. If adjusting the reading voice results 
in a change of language, the menus will automatically change to the same language. To add or 
delete voices and languages from the voice selection, please refer to the Settings Menu. 
 
Note: In case automatic language detection is enabled, this button only changes between 
voices of the detected language. For instance, if the detected language is English this button will 
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only change between the different English voices. With automatic language detection enabled, 
you will not be able to change the language of the menu. To change the menu language, either: 
1) disable automatic language detection, or 2) scan a document in your preferred menu 
language and change the voice once in the menu. 

5.2.5. View 
The “View” menu item is only available when a 
monitor is connected. By selecting the “View” 
button, the “View” menu will be opened. The “View” 
menu contains five buttons: 

• Color 
• Mode 
• Highlight 
• Size 
• Font 

5.2.5.1. Color 
To select another color combination, open the menu and navigate to the View button with the 
Back and Forward button or the arrow keys on the Magnification Feature Pack. Open the View 
menu with the Play / Pause button. Navigate to the Color button. Press the Play / Pause button 
again to cycle through the available high contrast text foreground and background color 
combinations.  
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The colors that can be selected are: 
• Black – White 
• White – Black 
• Yellow – Black 
• Black – Yellow 
• Yellow – Blue 
• Blue – Yellow 
• Black – Red 
• Red – Black 
• Black – Green 
• Green – Black 
• Black – Purple 
• Purple – Black 
• Blue – White 
• White – Blue 
• Black – Amber 
• Amber – Black 

Note: This option is not available in Page full color mode. 
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5.2.5.2.  Mode 
To select the default viewing mode, open the menu and navigate to the View button with the 
Back and Forward button or the arrow keys on the Magnification Feature Pack. Open the View 
menu with the Play / Pause button. Navigate to the Mode button. Press the Play / Pause button 
again to cycle through the available different viewing modes. The viewing modes that can be 
selected are Column, Line, Page high contrast and Page full color.  
 
The Page Mode shows a photograph of the document in its original layout, including the 
pictures. There are 2 Page modes, the high contrast Page mode and full color Page mode. In 
the high contrast Page mode, the text is displayed in the selected high contrast colors. 
In the Column mode the text is reformatted and displayed in a column to fit the width of the 
screen regardless of the text size. Pictures are not shown in this mode.  
In Line mode the text is reformatted and displayed in one continuous line, and the highlighted 
word is always displayed at the centre of the screen. Pictures are not shown in this mode. 

5.2.5.3. Highlight 
This option lets you choose a word highlight, line highlight, inverted block highlight, or no 
highlight. Both the color of the word and line highlight can be changed from red to yellow. The 
use of the inverted block highlight is limited to the Column and Line view. In Page view and 
Overview the inverted block highlight will change into an inverted Box highlight. The red word 
highlight is the default.  
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5.2.5.4. Size 
This option lets you change the font size. In Column and Line view the font size is defined in 
points, similar to the font size in Microsoft Word. In Page view the font size is defined in steps.  

5.2.5.5. Font 
This option lets you choose between an Arial, Arial Bold, Verdana or Verdana Bold font for the 
Column or Line view. In Page view the original picture and font of the document are displayed.  

5.2.6. Settings 
Select the “Settings” button to enter the Settings 
menu. The Settings menu contains five buttons: 

• Voice 
• Options 
• Resolution 
• Defaults 
• About 

5.2.6.1. Voice 
The Voice button in the Settings menu opens a list with all available reading voices and 
languages. Selecting this button will open the languages list.  
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To add or remove a reading voice, select the language from the list by using the Back button or 
Forward button on the ClearReader+ or the arrow keys on the Magnification Feature Pack. 
 

      
 

Press the Play button to select the language and to view the list with the available voices for that 
language. To select or deselect a voice, press the Play / Pause button. A checkmark in front of 
the voice name will indicate if it is enabled. When the voice is enabled, it will be available under 
the “Voice” button in the main menu. By deselecting a voice, the voice will be removed from the 
available reading voices. The languages of which a reading voice is selected, will appear at the 
top of the list with languages, and be marked with a checkmark.  
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5.2.6.2. Options 
The options menu contains the following 
configuration settings: 

• Text recognition quality 
• Automatic language detection 
• Column filter 
• Capture mode 

 
 

5.2.6.2.1. Text recognition quality 
This option lets you set the recognition quality.  
The “Optimal” setting is the recommended mode and 
will offer the best text recognition quality. The “Fast” 
mode is for simple documents without columns and 
pictures. The “Fast” mode is up to 30% faster than 
the “Optimal” mode. 
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5.2.6.2.2. Automatic language detection 
When the “Automatic language detection” is enabled, 
the ClearReader+ will detect the language of the text 
reading zone or paragraph, and automatically select 
the correct reading voice. The ClearReader+ can 
detect multiple languages in one page. To enable the 
language detection, first enable up to maximum five 
languages. To do this, go to the “Voice” selection 
menu, and enable a language by selecting at least 
one voice per language. Do this for a maximum of 5 
languages. Now make sure the language detection is 
enabled in the “Options” menu.  
 
Note: In case the ClearReader+ is not able to detect the language, the langage of the menu is 
being used. If English is one of the selected languages, the ClearReader+ will use an English 
voice and will ignore the menu language.   
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5.2.6.2.3. Column Filter 
This option contains two settings:  

• Ignore incomplete columns  
• Include incomplete columns 

 
When “Ignore incomplete columns” is enabled, the 
OCR algorithms will try to detect if text columns are 
cut off at the left or right margin of the picture. 
Disabling the filter will include partial columns and 
will read all detected text on the page.  The “Ignore 
incomplete columns” is the recommended and 
default setting, offering the most comprehensive text recognition. The “Include incomplete 
columns” will try to detect all text on the page, but may result in incomprehensive text at the 
beginning or end of the document.  
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5.2.6.2.4. Capture Mode 
This option contains two settings:  

• Manual 
• Automatic 

 
In the default “Manual” mode, you must press the 
Scan button to capture a page. If you select 
“Automatic”, you do not need to press the Scan 
button. Instead, a motion detector senses when you 
put a new page under the camera, waits until no 
motion is detected, and then captures the image. Once you leave the menus and place a page 
under the camera, the image is captured automatically. 
 
Automatic mode is recommended when capturing multi-page documents for a more streamlined 
reading experience. It also works well for single-page captures, especially if you capture 
numerous single-page documents. The motion detector can respond to unintentional 
movement, such as a desk being shaken or a hand passing under the camera; therefore, 
reduce the amount of time between scans to minimize the risk of an accidental capture. 
 
To discontinue automatic scanning, press the Scan button. The light turns off and the camera 
stops looking for motion. Re-start automatic capture mode by pressing the Scan button. To 
revert to manual mode, return to this menu and select “Manual”. 
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5.2.6.3. Resolution 
This option lets you manually set the monitor resolution. It is recommended to only change the 
resolution if the automatic detection fails. After changing the resolution, the ClearReader+ needs 
to restart. 

5.2.6.4. Restore defaults 
If you wish to restore the default settings, select this button. You will be prompted if you are sure 
you want to restore the defaults. To restore the defaults, select “Yes”. To cancel restoring the 
defaults, select “No”.  
 

  
 
 

 
 

 
 
 
 
 
 

Default settings 
 

View High contrast on 
Color Black on white 
Highlight Word 
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5.2.6.5. About 
The About screen shows the version of the Application interface, camera interface, OCR 
interface and the mains frequency. 
 



ClearReader+ Optelec 
 

46 English 

6. Power and battery use 
This chapter only applies to the ClearReader+. The ClearReader+ is the only ClearReader that 
has an integrated battery. The ClearReader+ Basic is AC powered and needs to be powered by 
a mains power source.  

6.1. Checking the ClearReader+battery status 
Press the Back and Forward buttons together to check the battery status of the ClearReader+. 
The ClearReader+ will announce the status in percentage, where 100% means a fully charged 
battery. If the battery is low, please charge the battery with the dedicated power supply. 

6.2. Charging the ClearReader+ battery 
To charge the ClearReader+, connect the power supply to the power connector located at the 
rear side of the unit. Plug the power cord into a power outlet. 
 
Charging the ClearReader+ takes approximately 3 hours. A fully charged ClearReader+ can 
operate for approximately 5 hours. Please note that, for safety reasons, only the power supply 
supplied by Optelec should be used to charge the ClearReader+. 

6.3. Extending the ClearReader+battery life 
To ensure the battery pack maintains maximum capacity, disconnect the ClearReader+ from the 
power source at least once a month and operate it on battery power until the battery pack is 
empty. 
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7. Troubleshooting 
If the power supply does not power the ClearReader+. 
 Check the connections. Make sure that the power supply is firmly connected to the 

ClearReader+ and to the power outlet. 
 If the power supply still does not power the unit, contact your Optelec distributor. 

If the battery does not power the ClearReader+. 
 The battery may be empty. Connect the power supply to charge the battery. 

If the text you are reading does not make sense. 
 Make sure your reading language is the language of your document.  

If the text recognition takes unusually long before starting to read your document. 
 Make sure your reading language corresponds with the language of your document.  

If the ClearReader+ does not read the whole line of a document / column / table. 
 The automatic column recognition may be on. Press and hold the Scan button for 2 

seconds to disable the column recognition and to switch to “TableMode”. 
If the ClearReader+ does not respond to the Scan button.  
 Open the camera arm and try it again. 
 If the Scan button still does not respond, check if the unit is powered. 
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If the ClearReader+ does not respond to any button. 
 Make sure the battery is not empty. If the battery is empty, connect the power supply to 

charge the battery. 
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8. Optelec Offices Worldwide 
Optelec kantoren wereldwijd | Optelec dans le monde | Filiali Optelec nel mondo |  
Optelec oficinas por todo el mundo | Optelec Zweigniederlassungen Weltweit 

 
Optelec Nederland BV 
Pesetastraat 5a 
2991 XT Barendrecht 
The Netherlands 
T: +31 (0)88 678 3555 
www.optelec.nl 

Optelec U.S. 
17757 US Hwy 19 N, Ste 200 
Clearwater, FL 33764 
U.S.A. 
T: +1 (800) 444-4443 
www.optelec.com 

Optelec Canada 
1812 Marie-Victorin 
Longueuil, QC J4G 1Y9 
Canada 
T: +1 (450) 677-1171 
www.optelec.com 

Optelec GmbH 
Fritzlarer Strasse 25 
34613 Schwalmstadt 
Germany 
T: +49 669 196 170 
www.optelec.de 

Optelec Europe 
Pesetastraat 5a 
2991 XT Barendrecht 
The Netherlands 
T: +31 (0)88 678 3444 
www.optelec.com 

Optelec Limited 
Unit B, Plot 5 
Merlin Way 
Quarry Hill Industrial Estate, 
Ilkeston, Derbyshire 
DE7 4RA 
United Kingdom 
T: +44 1923 23 13 13 
www.lowvisionshop.co.uk 

Optelec NV 
Baron Ruzettelaan 29 
8310 Brugge 
Belgium 
T: +32 (0)50 35 75 55 
www.optelec.be 

 

http://www.optelec.de/
http://www.optelec.com/
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